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How to Use This Book

This manual provides complete information for operating
Apple Fax.
It is assumed that you are familiar with basic Macintosh
desktop operations. If not, refer to the Macintosh Guide in
the Guide menu (the Guide menu is the one with the
question mark icon), or the documentation that came with
your computer.
Part I

m

Chapter 1

m

Chapter 2

introduces the software for sending, receiving,
and managing faxes with your Macintosh computer. It guides
you through the steps for sending your first fax, getting
ready to receive faxes, and using the QuickFax feature.
Everything you need to get started is included in this
chapter.
provides more complete information on the
Apple Fax main window. It explains in detail all of the
interface elements of the main window and how they pertain
to managing faxes and accessing important parts of Apple
Fax and related programs.

xi

Part II

m

Chapter 3

m

Chapter 4

m

Chapter 5

m

Chapter 6

covers fax send advanced features using
Fax Sender and Fax Sender GX, as well as managing
recipients and recipient lists using Apple Address Book.
covers fax receive advanced features.

covers viewing, editing, and printing faxes. It
also explains the use of the OCR (Optical Character
Recognition) feature for converting all or part of a received
fax to text.
covers creating and managing customized fax

cover pages.
m

Chapter 7

m

Chapter 8

m

Chapter 9

covers the log of incoming and outgoing faxes
that Apple Fax maintains.
covers all of the Preferences settings and
options of the Apple Fax program.
covers the use of Apple Fax Gateway for

PowerTalk.
What You Need

To use Apple Fax you need
m System 7.1 or later
m a communications device compatible with Apple Fax
To use the drag and drop capabilities in Apple Phone you
also need
m System 7.5 or later, or the Macintosh Drag & Drop extension
for System 7.1.1 or 7.1.2
To send faxes to address book entries using Apple Fax you
also need
m Apple Address Book

xii
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Apple Fax Quick Start

In this chapter

This chapter introduces you to the basic operation of Apple
Fax. It gives you step-by-step instructions for the most
commonly used functions, including
m sending a fax
m receiving and printing a fax
m using Quick Fax
Before you begin

Please make sure that your modem hardware is properly
installed. Depending on your configuration, installation may
need to be done by your Apple-authorized service provider.
You must also install the software before using it.
To understand the information presented in this chapter,
you should be familiar with the basic operation of your
Macintosh and should know how to print a document. Refer
to the Macintosh Guide in the Guide menu (the one with
the question mark) or the documentation that came with
your computer if you need help with these basic functions.

1

Sending a fax

This section introduces Apple Fax and guides you through
the steps for sending a fax. If you follow these steps, you will
learn everything you need to know about basic fax send.
Advanced fax send features are covered in Chapter 4,
“Fax Send Advanced Options.”
Faxing is like printing

You can think of sending a fax as printing to a printer that is
connected to your computer by a telephone line. Any
document or window that can be printed by a program or by
the system can be sent as a fax. To send a document as a fax
you follow all of the same steps that you would to print it,
plus the additional step of identifying the recipient or
recipients and their fax numbers.
Preparing your document

Before sending a document as a fax, prepare it as you would
prepare it to print. You can use any program that prints,
such as a word processor, spreadsheet, or drawing program.
For your convenience, a sample document in SimpleText
format, named “My First Fax”, has been provided for you in
the Fax Folder inside the Telecom Applications folder on
your hard disk.
1 Open the Telecom Applications folder, then open the Fax

Folder, then open “My First Fax” by double-clicking it.
It opens as a SimpleText document.
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Setting preferences

Before sending your first fax, you need to configure
Apple Fax for your modem. Once this is done, you won’t
have to worry about the basic modem preferences again
unless your modem configuration changes. The first time
you run Apple Fax a setup window automatically opens for
you to configure your modem.
To start Apple Fax
1 Choose Apple Telecom Status from the Apple (K) menu.

Apple Telecom Status opens.

Apple Fax icon

2 Click the Apple Fax icon, or choose Open Apple Fax from

the File menu.
Apple Fax opens and presents the setup window.

Apple Fax Quick Start
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3 Read the introductory text, then click Next or select

“Choosing a Modem” from the Topics pop-up menu.
The “Choosing a Modem” panel appears

4 Choose your modem type from the modem pop-up menu,

then click Next.
Important If you choose a modem type that attaches to an

external serial port or PC card slot, be sure to set the port or
slot correctly in the control panel provided with your
modem (the Apple Serial Modem control panel, for
example). Unless the port is set correctly, Apple Fax will not
be able to communicate with your modem.
If you have an internal modem or a GeoPort Telecom
Adapter, there is no choice to make.
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The “Changing your settings” panel appears.

5 The descriptive text explains how to change these and other

settings. Read it, then click Done to confirm your settings
and close the setup window.
These are the basic settings that you must make before you
can use Apple Fax to send and receive faxes.
See also: Chapter 8, “Apple Fax Preferences” for a complete
explanation of these and other preference options.

Apple Fax Quick Start
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Choosing Fax Sender or Fax Sender GX

Before sending your fax, you need to choose either Fax
Sender or Fax Sender GX, depending on your configuration,
to image and transmit your fax. Choosing Fax Sender or Fax
Sender GX is like choosing a printer.
1 Open the Chooser from the Apple (K) menu.

The Chooser appears.

2 From the panel on the left, select Fax Sender GX if you have

QuickDraw GX installed as part of your system. Otherwise,
select Fax Sender.
3 If you selected Fax Sender GX in step 2, click Create. This

creates a desktop printer icon for Fax Sender GX. You can
send documents as faxes by dragging and dropping them on
this icon.
See also: Chapter 4, “Fax Send Advanced Options” for a
complete explanation of this feature.
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4 Close the Chooser. Fax Sender or Fax Sender GX is now

selected so that you can use the Print command to send
faxes.
Important As an alternative to the above method of

selecting Fax Sender, hold down the Control and Shift keys
while choosing Print from the File menu. This shortcut does
not deselect your regular printer; you return automatically to
your previous printer settings for printing after the fax is
sent. This shortcut works with Fax Sender in conjunction
with all other programs. It does not work for Fax Sender GX;
for Fax Sender GX, create a desktop printer icon instead.
5 Return to SimpleText to send the document“My First Fax”.
Addressing your fax

You can send a fax to one or more recipients. Using the
Apple Address Book program, you can create entries for
individuals, companies and groups. For example, if you have
a group of colleagues to whom you regularly send the same
faxes, you can create a distribution list (a group of individual
and company entries) and send a fax to everyone in the list
in a single step.
See also: Chapter 4, “Fax Send Advanced Options” and the
Apple Address Book User’s Guide for a complete explanation
of recipients, distribution lists, and interaction between
Apple Fax and the Apple Address Book.

Apple Fax Quick Start
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You can also send a fax to a recipient who does not have an
address book entry simply by typing the fax number into the
“Other Recipient Number” field of the Fax Sender print
dialog box. This is the method used in this example.
1 Choose Print from your program’s File menu.

The Fax Sender or Fax Sender GX print dialog box appears.
Both dialogs are shown below. If you are using Fax Sender,
skip ahead to step 3.

The Fax Sender print dialog box

The Fax Sender GX print dialog box
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2 Make sure that Fax Sender GX is shown in the “Print To”

pop-up menu. If not, select it from the pop-up menu. For
now, just accept the default settings and click Fax.
The Fax Sender print dialog box appears.
See also: “Sending faxes using Fax Sender GX” in Chapter 3,
“Fax Send Advanced Options” for a complete explanation of
Page Setup and Print dialog box options.
3 Type the fax number of your recipient into the “Other

Recipient Number” field.
Cover page information

If you wish, you can include a cover page for your fax.
Several sample cover pages are automatically installed for
you when you install Apple Fax. You can create and install
your own customized cover pages if you wish. The cover
page information for the recipient is filled in automatically
from the recipient entries in the Apple Address Book.
Information about you, the sender, is filled in from the Apple
Fax Personal preferences.
See also: Chapter 3, “Fax Send Advanced Options” and
Chapter 6, “Creating and Managing Cover Pages” for a
complete explanation of cover page options and Chapter 8,
“Apple Fax Preferences” for an explanation of how to enter
the information about yourself.
1 If you want a cover page, select a cover page from the Cover

Page pop-up menu.
2 If you wish to include a note on the cover page, enter its

text in the Cover Page note field.
Cover pages may include a Note field for a brief (up to 255
characters), descriptive note about the contents of the fax.

Apple Fax Quick Start
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Previewing your fax

Before sending, you can preview your fax as it will appear on
your recipient’s fax machine.
1 Click the Preview button in the Fax Sender print dialog box.

You can preview your fax, move through the pages, and
change the scale according to your wishes.
See also: “Preview options” in Chapter 3, “Fax Send
Advanced Options” for more information on fax preview
options.
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Sending your fax

You can send your fax from the preview dialog box or from
the Fax Sender print dialog box.
1 Click Send in either the preview dialog box or the Fax

Sender print dialog box.
Your fax, including the cover page, if any, is imaged. Then,
the recipient’s number is dialed and your fax is transmitted
when the remote fax machine answers.
Monitoring the status of your fax

Once you have have initiated the sending of your fax, you
can monitor its progress.
Apple Fax status information

Status information about sent faxes is given in Outgoing
view.
1 Click the Outgoing button in the main window to display

Outgoing view.

Apple Fax Quick Start
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You should see the fax you just sent at the top of the list.
(Faxes are normally displayed most recent first. You can
choose to display them according to other criteria, if you
like. See “Sorting faxes that have been sent” in Chapter 2.)
You can view its status in the Status column on the right side
of the window. The status is shown as either Sent or Failed
upon completion.
Apple Telecom Status program

If you wish to monitor the status of the modem in more
detail as it sends your fax, you can do so by opening and
viewing the Apple Telecom Status program.
1 Click the Telecom Status icon in the button bar in the Apple

Fax main window.

Telecom Status

The Apple Telecom Status program appears.

The information about your fax transmission is updated at
each stage of the process. The Apple Telecom Status
program and Apple Fax are designed to work together. You
can keep both of them open at the same time if you like.
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Fax log information

You can access detailed information about sent and received
faxes using the fax log. Information about each transmission
or reception is stored in the fax log file.
To view the log information once your fax has been sent
1 Click the Log icon in the button bar in the Apple Fax

window.

Apple Fax log

The fax log appears.

The information for the fax you just sent appears at the top
of the list.
See also: Chapter 7, “Using the Apple Fax Log” for more
information on the log, and “Log preferences” in Chapter 8,
“Apple Fax Preferences” for more information on fax log
preference options.

Apple Fax Quick Start
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Receiving a fax

You can receive, view, edit, and print faxes using Apple Fax.
This section explains how to set your environment up for
receiving, how to check for received faxes, and how to open
and print a received fax.
Preparing to receive faxes

In order to receive a fax, you must either set Apple Fax and
your modem to answer incoming calls automatically (autoanswer) or carry out the steps to receive a fax manually. This
section explains how to receive faxes automatically, as this is
by far the most common method.
To have incoming fax calls answered automatically
1 Click the Incoming button to display Incoming view.
2 Set the Fax Answering button to on.

Incoming fax calls will now be handled automatically by
Apple Fax. Reception happens in the background, so the
Apple Fax window does not have to be in front, or even
open, in order to receive a fax.
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Checking for received faxes

When you look at Incoming view, received faxes are
displayed in the order in which they were received, with the
most recent at the top of the list. Faxes with a checkmark to
the left of their name have been read; those with no
checkmark are unread.

Read

Unread
Viewing and printing a fax

The Apple Fax main window is for managing sent and
received faxes. To view, edit, or print a received fax, open it
in a fax view window.

Apple Fax Quick Start
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Opening a fax for viewing

To open and view a received (or sent) fax
1 Select the fax you want to read from the list of received (or

sent) faxes.
2 Click Open.

You can also double-click the icon of the fax you want to
view.
The fax appears in a fax view window.

See also: Chapter 5, “Viewing, Editing, and Printing Faxes”
for a complete explanation of fax view windows and options.
Printing a fax

You can print a fax from the fax view window.
To print a fax that you have opened in a fax view window
1 Make sure that you have selected a printer in the Chooser

(not Fax Sender or Fax Sender GX).
2 Select Print from the File menu.
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Quick Fax

In many cases you may want to send a quick note or memo,
essentially a cover sheet with some additional information in
the Note field. Quick Fax allows you to send a fax of this type
without preparing a document beforehand in a program
such as a word processor.
You can also add other documents as enclosures and send
them with your Quick Fax without opening the program that
created them (although it must be installed on your hard
disk). Sending a Quick Fax with an enclosure is the fastest
way to send a document when the program that created it is
not open.
Both of these types of Quick Fax are explained in the
following sections.
Sending a single sheet Quick Fax

To send a single sheet Quick Fax
1 Click the Quick Fax button in the Apple Fax window. (Quick

Fax is available in both the Outgoing and Incoming views.)

Quick Fax

Apple Fax Quick Start
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The Quick Fax window appears.

2 Enter the text you want to appear in the Subject field of the

cover page.
The Subject text you enter is also used to identify the fax in
Outgoing view in the Apple Fax main window.
3 Select the cover page you want to use for your Quick Fax

from the Cover Page pop-up menu.
4 Enter the fax number of your recipient in the “Other

recipient number” field if you don’t have an address book
entry for your recipient.
Addressing a Quick Fax to one or more recipients for whom
you have address book entries is discussed later in the
section “Addressing a Quick Fax”.
5 Enter the note or memo text that you want to appear in the

Note field of the cover page in the text field.
6 Click Send.

These are the only steps you need in order to send a single
sheet Quick Fax with your text in the Note field.
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Adding enclosures

You can add documents created by a program such as a
word processor or paint program as enclosures to a Quick
Fax. When you enclose a document in a Quick Fax, Apple
Fax tells the program that created it to open it and print (fax)
it during the send process. You must have the program
installed on your hard disk in order to send its documents as
enclosures.
Quick Fax enclosures work with any program that supports
printing through the Print Apple Event. Most programs that
print support the Print Apple Event.
To add one or more enclosures to a Quick Fax
1 Click the Enclosures button in the Quick Fax window.

The file selection dialog box appears.

2 Navigate to the folder that contains the document you want

to enclose, if necessary.
3 Double-click the file that you want to enclose, or select it,

then click Add.

Apple Fax Quick Start
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You can repeat these steps for as many enclosures as you
wish. Each time you add a file, its name appears in the
enclosures list. To remove a file from the list, select it, then
click Remove.
The Quick Fax file selection dialog box supports Drag and
Drop. You can drag files from the Finder into the “Files to
add” field as an alternative to steps two and three.
4 When you have finished adding enclosures, click Done.
Addressing a Quick Fax

If you want to send a Quick Fax to a recipient or list of
recipients for whom you already have entries in your address
book, you can choose them from the recipients dialog box
instead of typing a number into the “Other recipient
number” field.
To address a Quick Fax to recipients from one or more
address books
1 Click the Recipients button in the Quick Fax window.

The Address Book dialog box appears.
Click here to
select another
address book.

2 If necessary, select the address book you want to use by

clicking the icon and choosing from the list of registered
address books.
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3 For each recipient, select the corresponding entry in the

scrolling list, then click To.
4 When you have added all recipients to the list, click Done.

You can add new entries to the current address book by
clicking New; you can edit an existing entry by selecting it
and clicking Edit.

See also: Apple Address Book User’s Guide for a complete
explanation of creating, editing, and managing address
books.

Apple Fax Quick Start
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Apple Fax Main Window

In this chapter

This chapter covers the Apple Fax main window, which serves
as a central location for displaying information about faxes you
send and receive, managing faxes, and accessing frequently
used features of Apple Fax and related programs.
m Apple Fax main window
m Outgoing fax view
m Incoming fax view
m Managing faxes
m Using the button bar to access features of the Apple Fax
program and related programs
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Accessing Apple Fax

When you install the Apple Telecom software, the Installer
places Apple Fax in Fax Folder in the Telecom Applications
folder on your hard disk. You can start Apple Fax by doubleclicking its icon.
Apple Fax is also available from the Apple Telecom Status
program. For your convenience, Apple Telecom Status is
installed in the Apple (K) menu.
To access Apple Fax
1 Choose Apple Telecom Status from the Apple (K) menu.
2 Click the fax machine icon or choose Open Apple Fax from

the File menu.
Apple Fax main window

The Apple Fax main window presents two different views—
Outgoing and Incoming. You can switch between them by
clicking the Outgoing and Incoming buttons in the main
window. Depending on the view you choose, the buttons
and options available in the main window change. In either
view information about sent or received faxes is displayed.
The following sections cover both views, first Outgoing, then
Incoming.
You can resize the main window in the vertical direction, by
dragging the grow box in the lower right corner. Clicking the
zoom box in the upper right corner toggles the window size
between full screen and the smallest size you have used.
Clicking the close box in the upper left corner closes Apple
Fax main window. You can reopen it by selecting Apple Fax
from the Windows menu.

24
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Outgoing view

Outgoing view shows you information about faxes you have
sent or those waiting to be sent. You can also access
information of about the recipient or recipients of any fax.
Understanding the display information

Faxes that have been sent or are waiting to be sent are
shown in the order that they were sent or are scheduled to
be sent, with the most recent first. You can view them in
reverse order, oldest first, if you wish. See “Sorting faxes that
have been sent” later in this chapter.

Apple Fax shows you the name, date and time, number of
pages, and status of each fax. The name, which you can edit
if you like, is the name of the document as it was sent with
Fax Sender or Fax Sender GX, or the text you entered in the
Subject field of a Quick Fax.

Apple Fax Main Window

25

The status of a fax is Sent for a fax that has been sent
successfully, Deferred for a fax that is waiting to be sent at a
later time, or Failed, if the fax could not be sent for some
reason. For a Failed fax, Apple Fax shows you the number of
recipients to whom the fax could not be sent. For example,
Apple Fax shows a status of “1 of 3 failed” for a fax that you
sent to three recipients and was sent successfully to two of
them. In addition, the icon at the far left of the display is
different depending on the status.

Deferred fax
Failed fax

Successfully
sent fax
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Viewing recipient information

In order to keep the status information from becoming
cluttered, information about the recipient or recipients is
hidden by default and shown only when you specifically
choose to do so.
To display recipient information about a fax in the list
1 Click on the small triangle to the left of the fax icon.

The recipient list for the fax opens and each recipient or
group of recipients to whom the fax was addressed is shown.

Apple Fax shows the name, fax number, and status for each
recipient on a separate line.
2 For a recipient that is a distribution list entry, click on the

small triangle to the left of the name to display each
recipient in the group individually.
3 To get more information about a recipient, double-click the

recipient, or select the recipient, then choose Recipient Info
from the Fax menu or click the Open button.

Apple Fax Main Window

27

A recipient Info window appears.

For a fax that is waiting to be sent, you can edit the fax
number or the send time. You cannot change this
information for faxes that have already been sent.
Deleting a fax that has been sent

Fax documents that you send and receive are saved in a
special fax image format. You can keep as many sent and
received fax documents as you have disk space to hold.
However, you might want to delete faxes that you no
longer need.
To delete faxes from the list
1 Select the faxes you want to delete. You can select multiple

faxes by shift-clicking (hold down the Shift key as you click).
2 Click Delete.

A dialog box asks you to confirm.
3 Click OK.

The selected faxes are deleted. You can also delete a fax by
dragging it from the main window to the trash.
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Sorting faxes that have been sent

You can sort the list of sent faxes by document name, date,
number of pages, or status. Date is the default sort criterion
and it is the one that you will likely use most of the time.
To choose a sort criterion
1 Click on a column name (Document, Date, Pages, or Status)

to sort the list by that criterion. To sort in reverse order,
from the end of the alphabet or oldest fax, for example,
option-click the appropriate column.
Readdress, Resend, and Merge

In Outgoing fax view, the button next to the Print button is
named Readdress, Resend, or Merge, depending on the
faxes selected from the list.
If you select a fax that is waiting to be sent, the button is
named Readdress. It lets you modify the recipient list for the
waiting fax before it is sent.
If you select a fax that has already been sent, the button is
named Resend. It lets you resend the fax to the same or
different recipients.

Apple Fax Main Window
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If you select multiple faxes, the button is named Merge. It
lets you combine several faxes into a single fax and send the
combined document to one or more recipients.

When you select one or more faxes and click Resend,
Readdress, or Merge, a window similar to the Quick Fax
window appears.

You can fill in or change the various options and then click
Resend, Readdress, or Merge.
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Opening and viewing a fax that has been sent

You can open a sent fax into a fax view window for editing or
printing by selecting it and clicking Open or by
double-clicking it.

See also: Chapter 5, “Viewing, Editing, and Printing Faxes”
for more information.
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Incoming view

Incoming view shows you information about faxes that you
have received.
Understanding the display information

Received faxes are shown in the order that they were
received, most recent first. You can view them in reverse
order, oldest first, if you wish. Apple Fax shows you the
document name, the date and time of reception, and the
number of pages for each received fax. Apple Fax names
received faxes using the sender information (provided by the
sending machine, also called station ID by some fax
machines) and the date.
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Editing the name of a received fax

You can edit the name of a received fax by selecting the text
you want to edit and then typing the new information. Since
the sender information is often a phone number, this allows
you to change it to something more easily identifiable.
Sorting faxes that have been received

You can sort the list of received faxes by document name,
date received, or number of pages. Date is the default sort
criterion and it is the one that you will likely use most of
the time.
To choose a sort criterion
1 Click on a column name (Document, Date, or Pages) to sort

the list by that criterion. To sort in reverse order, optionclick the appropriate column.
Forwarding a fax that has been received

You can forward a fax that you have received by selecting it
and clicking Forward. The Forward button functions in a
similar manner to the Readdress, Resend, and Merge buttons
discussed in the section on Outgoing fax view.
To forward a fax
1 Select the fax you want to forward, then click Forward.
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The Forward Fax window appears.

2 Enter the information you want, then click Forward.
Deleting a fax that has been received

Deleting received faxes works in the same way as deleting
sent faxes.
To delete faxes from the list
1 Select the faxes you want to delete. You can select multiple

faxes by shift-clicking (hold down the Shift key as you click).
2 Click Delete.

A dialog box asks you to confirm.
3 Click OK.

The selected faxes are deleted. You can also delete a fax by
dragging it from the main window to the trash.
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Opening and viewing a fax that has been received

You can open a received fax into a fax view window for
editing or printing by selecting it and clicking Open or by
double-clicking it.

See also: Chapter 5, “Viewing, Editing, and Printing Faxes”
for more information.
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Using the button bar

The Apple Fax main window contains a button bar that lets
you navigate easily to other parts of the program and links
Apple Fax to closely related programs, such as Apple Address
Book and Apple Telecom Status. It gives you a visual
reminder of several key fax-related functions and makes
them quickly accessible.
Apple Address Book

Quick Fax

Telecom Status

Apple Fax log

Preferences

Each of the buttons in the button bar is explained in the
following sections.
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Quick Fax

The Quick Fax button opens the Quick Fax window.

See also: Chapter 1, “Apple Fax Quick Start” for a
step-by-step tutorial on sending a Quick Fax, with or without
enclosures.
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Address Book

The Address Book button in the button bar opens the
Apple Address Book program, if it is not already open, and
brings it to the front. The Apple Address Book program
allows you to create entries for individuals, companies, and
distribution lists. It stores all of the necessary address,
phone, and fax information about them in a single place that
can be accessed by several different programs, including
Apple Fax.
See the Apple Address Book User’s Guide for a complete
explanation of all of the Address Book editing and
management options.
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Log

The Log button lets you access the Apple Fax log. All
outgoing and incoming fax transmissions have entries in
the fax log.

See also: Chapter 7, “Apple Fax Log” for a complete
explanation of fax log options, and “Log preferences” in
Chapter 8, “Apple Fax Preferences” for more information on
setting log preferences.
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Apple Telecom Status

The Apple Telecom Status button in the button bar opens
the Apple Telecom Status program, if it is not already open,
and brings it to the front. It gives detailed status information
about modem activity, which is updated continuously
according to the action in progress.

Shows Current status
Cancels
current activity
Opens Apple Phone

Opens Apple Fax

Apple Telecom Status is a separate program. It is not part of
Apple Fax. You can leave it open even when the Apple Fax
main window is not open. This can save screen space; the
Apple Telecom Status program lets you check on fax activity,
so that you only open the Apple Fax main window when
needed. You can use Apple Telecom Status to open Apple
Fax or Apple Phone, or to cancel the current activity.
The Apple Telecom Status window can be shown in
expanded or collapsed view. To expand or collapse it, click
the zoom box in the upper right corner.
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Preferences

The Preferences button lets you access the Preferences
window. You can use the preference settings to configure
Apple Fax for your particular environment and preferred way
of working.

See also: Chapter 8, “Apple Fax Preferences” for more
information on setting preferences.

Apple Fax Main Window

41

Part II

C

H

A

P

T

E

R

3
Fax Send Advanced Options

In this chapter

Apple Fax contains many advanced features for sending faxes
using Fax Sender and Fax Sender GX. These features are
covered in this chapter, including
m sending faxes using Fax Sender
m sending faxes using Fax Sender GX
m recipients and recipient lists
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Sending faxes using Fax Sender

You can send any document that can be printed as a fax
using either Fax Sender or Fax Sender GX, depending on
your system configuration. If you have QuickDraw GX
installed as part of your system, you will send faxes using Fax
Sender GX, which is covered later in this chapter. Otherwise,
you will use Fax Sender, which is covered in this section. Fax
Sender and Fax Sender GX are system software that allow
you to send faxes, in the same way that you print
documents, from any program that supports printing.
Choosing Fax Sender

Before sending a fax using Fax Sender, you need to select
Fax Sender to image your document, just as you would a
printer. There are two ways to select Fax Sender.
To select Fax Sender temporarily (just for imaging and
transmitting the current document) without changing
anything in the Chooser
1 Hold down the Control and Shift keys while choosing Page

Setup or Print from the File menu of your program.
The Fax Sender page setup or print dialog box appears.
When you finish sending your fax, the printer or other
device that was previously selected in the Chooser remains
selected and will be used for subsequent printing.
Important This shortcut works only with Fax Sender. It

does not work with Fax Sender GX; to use Fax Sender GX,
create a desktop printer icon instead.
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You can also make Fax Sender the selected output device,
just as you might select a printer. When Fax Sender is the
selected output device, each time you print from a program
or from the system your document is sent as a fax instead of
being printed.
To make Fax Sender the selected output device
1 Open the Chooser from the Apple (K) menu.

The Chooser appears.

2 Select Fax Sender from the upper left panel.
3 Close the Chooser.

Fax Sender remains selected until you choose another
device in the Chooser.
Note: If you plan to print to a printer and only occasionally

send faxes, you should leave your printer selected in the
Chooser and use the Control-Shift shortcut for selecting Fax
Sender when you want to send a fax.
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Fax Sender Page Setup

You select the options that are specific to imaging your
document as a fax, such as page size, orientation, and
quality, from the Fax Sender Page Setup dialog box.
To access the Fax Sender Page Setup dialog box
1 Make sure that Fax Sender is selected in the Chooser.
2 Select Page Setup from the File menu of your program.

As a shortcut for steps 1 and 2, hold down the Control and
Shift keys while choosing Page Setup from the File menu.
The Fax Sender Page Setup dialog box appears.

The page setup options are explained in Table 3-1.
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Table 3-1 Fax Sender Page Setup options
OPTION

RESULT

Orientation
Portrait

Transmits the fax vertically.

Landscape

Transmits the fax horizontally.

Reduce or Enlarge

Reduces or enlarges the fax by the
percentage you indicate.

Image Quality
Fine

Highest image quality, but longest to
send.

Standard

Normal image quality. Fastest to send.

Bitmap Alignment

Scales the Macintosh 72 dpi image so
that every pixel is matched evenly to
the fax machine resolution. Produces
the best quality image for bitmapped
documents, but enlarges the printed
image to 108% of actual size.
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Entering cover page information

You can include information about yourself, the sender,
along with the recipient information on the cover pages of
the faxes that you send. This information can include your
name, address, voice and fax numbers, fax header, subject,
and a text note for your fax. The fax header information,
sometimes referred to as the station ID, can be up to 20
characters long. It appears on each page of the faxes that you
send to fax machines or fax modems that support this
feature.
The information about you for cover pages is entered and
managed in the Apple Fax Personal preferences.
To enter cover page information
1 Choose Preferences from the Edit menu or the Windows

menu or click the Preferences button in the button bar.
The Preferences window appears.
2 Click Personal in the panel on the left to select the Personal

preferences.
The Personal preferences panel appears.
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3 Enter the information about yourself as you would like it to

appear on the cover page of faxes you send.
4 Click OK to confirm your settings and close the Preferences

window.
The information that you enter here is automatically filled in
by Fax Sender or Fax Sender GX when you send faxes that
have cover pages.
Note: If you have already entered your personal information

into the Personal preferences of Apple Address Book, you do
not need to reenter it in the Apple Fax Personal preferences.
Apple Fax will use the information from the Apple Address
Book preferences. When you change the information in one
place, it is updated in the other.
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Selecting a cover page

You can choose a cover page to be sent with your fax, or you
can choose to have no cover page. Several sample cover
pages are provided for you; they are installed when you
install the Apple Fax program. In addition, you can create
and install as many customized cover pages as you like.
See also: Chapter 6, “Creating and Managing Cover Pages”
for a complete explanation of creating and managing cover
pages.
You can select a cover page from the Fax Sender dialog box
or Quick Fax window that appears whenever you send,
readdress, resend, merge, or forward fax documents.
Choose cover page
from this pop-up menu

To select a cover page for a fax document from the
Fax Sender dialog box or Quick Fax window
1 Select the cover page (or None, if you don’t want any cover

page) from the Cover Page pop-up menu.
All installed cover pages appear in the pop-up menu.
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Preview options

You can preview any fax or Quick Fax document to see how
it will appear to the recipient when you send it.
To preview a fax from the Fax Sender dialog box or Quick
Fax window
1 Click Preview.

Your fax is imaged and displayed as it will appear when you
send it.

2 Use the scroll bar to navigate from page to page.
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3 Use the Scale icons in the lower left corner to set the

display size.

4 When you have finished previewing your fax, click Send to

send it as it is, or click Cancel.
Important If you click Cancel from a Quick Fax preview,

you return to the Quick Fax window. If you click Cancel from
a Fax Sender preview, you return to the program that
created the document you were previewing. You do not
return to the Fax Sender print dialog box.
Fax Sender Options

If you want to send your fax at a later time, you can set the
send time in the Fax Sender Options dialog box.
Setting send time

Fax Sender can send your fax immediately or at a later time
and date you specify. Send Immediately is the default since
you will probably most often want to send faxes immediately
once they are prepared and addressed. However, you may
want to set a specific send time if your recipient is in another
time zone or if you want to take advantage of reduced
long-distance toll charges during certain hours.
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To set the send time for a fax from the Fax Sender dialog box
or Quick Fax window
1 Click Options.

The Options dialog box appears.

2 Click the Send At radio button.
3 Set the time and date you want by selecting what you want

to change and using the up and down arrows.
The time and date you set must be later than the current
time and date.
4 Click OK.

The Options dialog box closes and you return to the Fax
Sender dialog box or Quick Fax window.
5 Click Send.

Your fax is imaged when you click Send and placed into the
Waiting to be Sent folder. You can see in the main window
Outgoing fax view that your fax has a status of Deferred. At
the time you selected, the modem dials your recipient and
transmits your fax.
Important Your computer must be on at the

specified time.
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Setting your location

Apple Fax uses the Location preferences settings in Apple
Address Book to take into account where you are “dialing
from” when you make an outgoing call.
Let’s assume, for example, that you are sending a fax to a
number in New York City that is stored in your address book
as 1-212-324-1005. If you set your location to New York,
Apple Fax knows that the “1” and the “212” area code are
unnecessary and dials only the local number (324-1005). If
you are in New Orleans, Apple Fax dials “1”, then the “212”
area code for New York, then the local number. By the same
token, if you store a number in Paris as 33-1-45 75 09 85, this
entire number is dialed when your location is set to New
York. But, if you are in Paris (and set your location to Paris in
the address book), Apple Fax dials only the local number
(45 75 09 85).
The location feature lets you keep all necessary information
for each entry in your address book and uses intelligence
about your current location to dial only the numbers
necessary for a given call.
You could also create a location that has a special prefix,
such as 0 or 9, to get an outside line from an office.
You set your location in the Apple Address Book
Preferences. Apple Fax only uses the information
stored there.
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To set your location
1 Click the Address Book button to open Apple Address Book.

Address Book

2 Choose Preferences from the Edit menu.
3 Click Locations to display the Locations panel.
4 Enter the desired location information.
5 Select your current location, then click Current.
6 Click OK to confirm your settings.

You need to remember to change the location when you
move from place to place in order to take advantage of
intelligent dialing.
Numbers that you type into the Other Recipient Number
field are dialed exactly as you enter them, regardless of the
location setting.
Important Changing your location for intelligent dialing

purposes does not change the settings or capabilities of your
modem. The country configuration of your modem is
dependent on the hardware, not on your location setting.
See also: Apple Address Book User’s Guide for more
information about setting the Location preferences.
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Using manual dialing

Apple Fax can send faxes using either automatic or manual
dialing. Most dedicated fax machines use automatic dialing.
This is the default method, since it is the setting you will
probably use most of the time. Automatic dialing offers the
convenience of using Apple Address Book and all of the
recipient and distribution list features of Apple Fax. When
you use manual dialing, you dial your recipient’s fax number
yourself using your handset.
You set the default dialing method in the Personal
preferences.
See also: Chapter 8, “Apple Fax Preferences” for a
description of how to set the Personal preferences.
Note: Manual dialing may not be available in certain

hardware configurations and in certain countries. To send a
fax using manual dial
1 Make sure that you have chosen Manual as the default

dialing method in the Personal Preferences.
2 Choose Print from the File menu.

The Fax Sender dialog box appears.
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3 Choose a recipient or type a number in the “Other Recipient

Number” field.
4 Click Send.

After Fax Sender has prepared your fax for sending, a beep
and a blinking icon notifies you that your fax can now be
sent by dialing manually.
5 Select Apple Telecom Status from the Application menu.

The Manual Dial dialog box appears.

6 Follow the instructions in the Manual Dial dialog box.

m Dial your recipient’s fax number from your handset.
m Click Send when you hear your recipient’s fax tone.
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Sending faxes using Fax Sender GX
Choosing Fax Sender GX

1 Select Chooser from the Apple (K) menu.

The Chooser dialog appears.

2 Scroll, if necessary, in the upper left panel until Fax Sender

GX is visible.
3 Click the Fax Sender GX icon to select it.
4 Click the Create button in the lower right corner.

This creates a desktop printer icon for Fax Sender GX. Using
desktop printer icons for drag-and-drop printing is discussed
later in this chapter.
5 Click the close box in the upper left corner to close

the Chooser.
Documents printed by programs will now be sent as faxes by
Fax Sender GX.
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Fax Sender GX Page Setup

Before sending your document, you need to select the
appropriate Page Setup options.
1 Select Page Setup from the File menu.

The Fax Sender GX Page Setup dialog box appears.

2 To see more options, click More Choices.

3 Select the Paper Type, Orientation, and Scale settings you

want. Be sure that Fax Sender GX is selected in the “Format
for” pop-up menu.
4 Click Format.
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Print dialog box options

You are now ready to send your fax.
1 Select Print from the File menu.

The Fax Sender GX print dialog box appears.

2 To see more options, click More Choices.

3 Select the General print icon in the upper left corner if it is

not already selected.
4 Be sure that Fax Sender GX is selected in the “Print to” pop-

up menu.
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5 Select the fax quality (Fine, Standard, or Bitmap Alignment)

you want from the Quality pop-up menu.
See also: “Fax Sender Page Setup” earlier in this chapter for
an explanation of the quality settings.
6 Click Fax.

Fax Sender GX images your fax. When imaging is complete,
the Fax Sender print dialog box appears.
You still need to set the transmission options, such as the
recipient’s fax number and cover information.
Addressing your fax

1 Choose recipients, fill in cover information, and select

transmission time, if you want to send your fax at a later
time.
2 Once you have addressed your fax, Click Send.

If you have selected Send Immediately (the default setting)
in the Fax Sender Options dialog box, your modem dials and
transmits your fax.
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Print time and send time

QuickDraw GX allows you to set the print time by selecting
the Print Time panel in the Print dialog box. This feature is
more useful for printing than for faxing, since Fax Sender
already allows you to specify the send time.

The time you set here is the time at which your document is
passed to Fax Sender GX for processing. The send time that
you set in the Fax Sender Options dialog box is the time at
which the modem dials your recipient’s fax number and
transmits your fax over the phone line.
Important If you want to send your fax at a specified time,

you should set the time in the Fax Sender Options dialog
box rather than in the Print dialog box. Leave Print Now set
in the Print Time panel of the print dialog box.
Drag-and-drop fax send

One of the most powerful features of QuickDraw GX is
drag-and-drop printing. You create a desktop printer icon for
a printing device, then simply drag documents and drop
them onto the icon for printing. You can send faxes the
same way using Fax Sender GX.
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If you followed the steps at the beginning of this chapter,
you have already created a desktop printer icon for Fax
Sender GX. Once you have created a desktop printer icon
for Fax Sender GX, you can simply drag a document and
drop it onto the Fax Sender GX icon to send the document
as a fax.
Sending a fax is just like printing, except that when you use
drag and drop to send a fax there is one additional
step—addressing your fax. When you drop a document onto
the Fax Sender GX desktop printer icon, the Fax Sender
dialog box appears, so that you can choose your recipient or
recipients just as you would ordinarily.
Using Fax Sender GX on an AppleTalk
network

Using Fax Sender GX, you can set up one machine on an
AppleTalk network to be a central server for sending faxes.
Other users on the network can then send faxes without
having the modem hardware installed in their computers.
In order to do this, the server must have the appropriate
modem hardware installed. Both the server and client
machines must have the Apple Fax software installed.
Sharing a fax server

Once you have created a desktop printer icon for Fax Sender
GX on the server, you can share access to it across the
AppleTalk network just as you might share a hard disk or
CD-ROM drive. See your Macintosh documentation for
details on the sharing process.

Fax Send Advanced Options

65

If you are sharing your modem on an AppleTalk network, try
to minimize the time you spend previewing faxes. While you
are previewing, remote Fax Sender GX users are temporarily
blocked.
Sending a fax from a network client

Once a fax send server has been created and shared on your
AppleTalk network, other users on the network can access it
as a client, provided that they have the necessary access
privileges.
When these conditions are met, sending a fax as a network
client is no different from sending a fax from your local
Macintosh. The only exception is that you must select
Servers in the “Connect via” pop-up menu in the
Chooser dialog.

Important When a transmission problem occurs, the error

is reported on the server, that is, the Macintosh that has the
modem hardware installed. Therefore, if you send faxes as a
network client, you should check the fax log of the server
frequently to verify that your faxes have been sent correctly.

66

Chapter 3

Recipients and recipient lists

Apple Fax offers a rich variety of features for sending faxes to
individuals and groups. If you frequently send faxes to the
same group of recipients, you can create a distribution list
entry that contains all of the individual or company entries in
the list and send a fax to all of them simply by dragging the
distribution list to the Recipients field of the Fax Sender
print dialog or Quick Fax window. You can also send the
same fax to individuals, companies, and distribution lists in
any combination by dragging their address book entries to
the Recipients field.
To address a fax to a list of individual, company, and
distribution list recipients
1 Prepare to send your fax by clicking the Quick Fax button or

by choosing Print from the File menu of another program.
Fax Sender or Fax Sender GX must be selected in the
Chooser, or you can hold down Control-Shift while choosing
Print if you are using Fax Sender.
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The Fax Sender or Quick Fax print dialog appears.

2 Click the Recipients button.

An Address Book dialog box appears, showing you a
scrolling list of the entries in the current address book.
Individual entry

Company entry
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3 To choose a different address book, click the icon to the left

of the current address book name.
A file selection dialog box opens showing the last folder
selected.

4 Choose the address book that you want to use if it is shown.

Otherwise, click Browse to locate it in another folder.
5 For each individual, company, or distribution list entry you

want to receive your fax, either drag the entry from the
address book to the Recipients field of the print dialog box,
or select the entry, then click To.
You can also add new entries by clicking New and entering
the information for a new entry, and you can edit an entry by
selecting the entry and clicking Edit. Although the address
book entries are managed by the Apple Address Book
program, changes you make within Apple Fax are reflected
the next time you open the address book with the
Apple Address Book program.
Important Address books may be used by other programs.

Remember that any modification that you make will affect
other programs that share the address book you are editing.
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6 When you have added all of your recipients to the Recipients

field, click Done.
Your fax is now ready to send to each recipient, including all
of the entries that make up a distribution list entry, when
you click Send.
See also: Apple Address Book User’s Guide for a complete
explanation of creating, editing, and managing the address
books that are used by Apple Fax and other programs.
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Fax Receive Advanced Options

In this chapter

This chapter introduces you to the advanced options for fax
reception, including
m setting up to receive faxes automatically
m checking for received faxes
m receiving a fax manually
m opening a received fax document
m forwarding a received fax to another recipient
Before you begin

This chapter expands on the material presented in Chapter 1,
“Apple Fax Quick Start”, and introduces some additional
options for receiving faxes. In order to understand the
material presented in this chapter, you should already be
familiar with Chapter 1.
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Receiving a fax

Apple Fax allows you to receive faxes automatically or
manually, as well as to view, edit, and print them. You can
also convert a received fax document to text using optical
character recognition (OCR), and forward a received fax to
one or more recipients.
Setting Apple Fax to receive

You will probably most often want to receive faxes
automatically. When set to receive automatically, Apple Fax
functions like a dedicated fax machine as long as your
computer is turned on. You can receive faxes unattended
while you are away from your computer, and you can receive
them in the background while you are doing other work.
The Apple Fax window does not have to be in front, or even
open, in order to receive a fax.
In order to receive a fax automatically, you need to set
Apple Fax to answer incoming calls automatically (Fax
Answering on).
To set Apple Fax to receive faxes automatically
1 Click the Fax Answering button in the main window so that it

moves to the “on” position.
Apple Fax will now receive incoming faxes automatically,
even if the Apple Fax main window is not open or if you quit
the program.
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Checking for received faxes

You can choose what Apple Fax does when you receive a fax.
According to the choice you make in the Notification
Preferences, Apple Fax can open the Apple Telecom Status
program when you receive a fax.
See also: “Notification preferences” in Chapter 8 for an
explanation of this option.
Even if you choose to have no notification for incoming
faxes, you can easily check to see if any have been received.
To check for received faxes
1 Click the Incoming button in the Apple Fax main window to

display Incoming view.

Received fax indicator

A blinking indicator in the Incoming button tells you that
you have received one or more new faxes.
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Received faxes are displayed in a scrolling list, sorted
according to the criterion you choose. If you leave the
default, Date, your faxes are displayed in the order they were
received, most recent first. You can easily distinguished new,
unread faxes from faxes you have read because a checkmark
appears to the left of the icon of all faxes that have
been read.

Receiving manually

Apple Fax allows you to receive faxes manually if you need to
do so. Although you will ordinarily want to receive faxes
automatically, there may be circumstances that necessitate
receiving manually, such as if your telephone and computer
share the same line. In that case, you will want to answer
incoming calls yourself using the handset and receive
manually once you determine that the incoming call is a fax.
Manual reception is only available when Fax Answering is set
to off in the main window.
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To receive a fax manually
1 Make sure that Fax Answering is set to off.
2 Answer the incoming call using the handset.
3 When your correspondent is ready to send you a fax, choose

Receive Manually from the Fax menu.
The Receive Fax dialog box appears.

4 When you hear the fax tone, click Receive.

When reception is complete, the fax appears in the list of
received faxes.
Opening a received fax document

To open a received fax document for viewing, editing, or
printing
1 Make sure you are viewing the main window display in

Incoming fax view (click Incoming, if necessary).
2 Select the fax you want to open from the list, then click

Open; or, double-click the fax you want to view.
The fax opens in a fax view window.
See also: Chapter 5, “Viewing, editing, and printing faxes” for
a complete explanation of all of the features available in fax
view windows.
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Forwarding received faxes

You can easily forward a fax you have received to one or
more recipients. You can also merge several fax documents
and forward them as a single document. When you forward
faxes, they do not need to be imaged since they are already
in fax format. This makes forwarding a relatively quick
operation, certainly quicker than sending the document
from the program that created it.
To forward a received fax
1 Make sure you are viewing the main window display in

Incoming fax view (click Incoming, if necessary).
2 Select the fax you want to forward from the list, then click

Forward.
The Forward Fax window appears.

The options for forwarding a fax (cover information,
recipients, etc.) are the same as for sending a fax.
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See also: Chapter 1, “Apple Fax Quick Start” and Chapter 4,
“Fax Send Advanced Options” for a complete explanation of
all of the features related to fax send (and fax forward).
Forwarding multiple faxes using Merge

If you select multiple received faxes in the main window list
by shift-clicking or command-clicking, the Forward button
becomes Merge. Merge works the same in Incoming fax view
as it does in Outgoing fax view. The documents you select
are merged into a single document and are forwarded to the
recipient or recipients you choose. Merge works just the
same as Forward, except that it combines multiple
documents.
Forward and Merge forward the document or
documents you select with their original cover pages as well
as whatever new cover you choose in the Forward Fax or
Merge Fax window. If you want to forward or merge received
faxes without their original covers, remove the cover pages
by cutting or clearing them in a fax view window and saving
the documents before forwarding or merging them.
Note:

See also: Chapter 5, “Viewing, Editing, and Printing Faxes”
for an explanation of cutting and clearing pages from a fax.

Fax Receive Advanced Options
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Viewing, Editing, and Printing
Faxes
In this chapter

This chapter introduces you to the options for viewing and
editing fax documents that you receive, including
m opening a fax
m viewing a fax
m printing a fax
m editing the pages of a fax
m selecting part of a fax to paste into a graphics document
m converting a fax to PICT format
m Optical Character Recognition (OCR)
Before you begin

You should be familiar with the information in Chapters 1
and 4 on receiving faxes.
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Opening a fax

You can open a fax for viewing, editing, or printing in a fax
view window. Ordinarily you will want to view and print
received faxes, but all of the operations described here can
apply to sent faxes as well. You can open as many
documents as memory allows and move among them using
the Windows menu. Each document that you open appears
as an item in the Windows menu.
To open a fax document
1 Select the document in the list of faxes in the Apple Fax main

window, then click Open; or double-click the document.
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Viewing a fax

Once you have opened a document, you can view it in several
different resolutions and in several orientations, as well as
navigate from page to page. Most of the operations for
changing the view are available from both the tool bar at the
top of the fax view window and from the FaxView menu.
Page navigation

View scale

Page orientation

OCR

Moving around a document

Use the scroll bars to position a page in the window and to
navigate between pages of a fax.
m To examine undisplayed portions of a page, use the vertical
and horizontal scroll bars at the right and bottom of the Fax
View window.
m To scroll pages, use the Next Page and Previous Page buttons
on the right side of the tool bar. The current page number is
shown as a pop-up menu between these buttons. Use the
buttons to move from page to page; use the pop-up menu to
go to a particular page.

Viewing, Editing, and Printing Faxes
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In addition to the paging buttons, the FaxView menu offers
commands for changing pages
m

Previous Page allows you to move backward one page.

m

Next Page allows you to move forward one page.

m

Go To Page displays a dialog box for moving to a

specific page.
Changing the page orientation

The options in the tool bar and in the FaxView menu allow
you to view your fax in whatever orientation you prefer.
The four orientation tools in the tool bar have the same
functions as the orientation items in the FaxView menu.
Rotate left

Flip page

Rotate right

Flip all pages

To change the orientation, either click the appropriate tool
or choose the appropriate command from the FaxView
menu.
m

Rotate left turns the current page 90 degrees

counterclockwise. (Option-click the tool to rotate all pages.)
m

Rotate right turns the current page 90 degrees clockwise.

(Option-click the tool to rotate all pages.)
m

Flip page rotates the current page 180 degrees.

m

Flip All pages rotates all pages 180 degrees.

Your last orientation operation can be undone using the
Undo command in the Edit menu.
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Scaling the view

You can view the currently displayed page at several
different scale settings—100%, 200%, 400%, and 800% of the
actual size—using the Zoom In and Zoom Out buttons in the
tool bar. The current scale is shown in a pop-up menu. Use
the Zoom In and Zoom Out buttons to go to the next larger
or smaller scale; use the pop-up menu to go directly to a
particular scale.
Zoom Out

Zoom In

Scale pop-up menu

Printing a fax

You print a fax the same way you print any document. See
“Print a Document” and “Printing Your Work” in the
Macintosh Guide in the Guide menu or the documentation
that came with your computer. Make sure the printer is
selected in the Chooser.
FastPrint

Apple Fax includes a FastPrint feature for printing fax
documents more quickly on PostScript printers. The speed
of printing can be significantly improved, but FastPrint
requires more memory (at least 1.5 Mb of additional
memory). You may need to increase the memory size
allocated to Apple Fax.
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To increase the Apple Fax memory partition
1 Select Apple Fax in the Finder.
2 Choose Get Info from the File menu (x-I).
3 Increase the number in the Preferred size field by at least

1500 K.
To enable FastPrint
1 Check the FastPrint checkbox in the Apple Fax print dialog

box.
Important

FastPrint only works with PostScript printers.

Editing a fax

You may need to recorde pages, eliminate pages, or
combine pages from several faxes. Editing in fax view
windows is similar to editing in other applications such as
paint programs. Generally, edit operations in Apple Fax fax
view windows affect an entire page. The page is the basic
unit in a fax document. Because a fax is a graphic image, you
cannot edit the text as you can in a word processor.
Copying, cutting, or clearing a page

Entire pages can be copied or cut to the clipboard for later
use, or cleared from the document.
To copy, cut, or clear a page
1 Make sure you’re viewing the page you wish to work on.
2 Choose Copy (x-C), Cut (x-X), or Clear from the Edit

menu.
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Copy places the current page on the clipboard. Cut places
the current page on the clipboard, removes it from the
document, and decreases the page count by one. Clear
removes the current page and decreases the page count by
one.
The clipboard holds one page at a time. Be sure to paste the
page into a Apple Fax or paint program document before
copying or cutting another page.
Pasting a page

You can paste a cut or copied fax page into any Apple Fax or
paint program document.
To paste a page
1 Select the page you want and cut or copy it to the clipboard.
2 Display the page that will follow the page you want to paste

in.
3 Choose Paste (x-V) from the Edit menu.

Notice that the page count increases by one page and that
Apple Fax places the page in front of the one previously
displayed.
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Selecting a portion of a page

Paste operations in Apple Fax only operate on entire pages.
However, you can select a portion of a page for pasting into
a document created by another graphics program. Apple Fax
provides a selection rectangle tool for selecting and copying
portions of documents.
1 Select the page you wish to copy from.
2 Move the pointer over the page.

Notice that the arrow pointer becomes a crosshair. It now
functions as a selection rectangle tool for selecting
rectangular areas.
3 Drag the selection rectangle tool across the image from the

upper left to the lower right, releasing the trackball or
mouse button when the image is enclosed.
A moving dashed line encloses the selected image.

4 Choose Copy Selection from the Edit menu.

Apple Fax places the selected image at current resolution in
PICT format in the clipboard.
5 Make your graphics program document the active window,

then choose Paste from the File menu.
The selected image appears in your document.
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Converting a fax to a PICT file

Apple Fax allows you to save a fax in Apple Fax or in PICT file
format using the Save As command. Apple Fax documents
can be opened only by the Apple Fax program. PICT files can
be opened by many graphics programs. In other words, the
Save As command acts as a conversion tool for fax
documents.
1 Choose Save As from the File menu.

The Save As dialog box appears. Notice the Format pop-up
menu at the bottom of the dialog box.

2 Change the document type using the Format pop-up menu.
3 Rename the document if you wish, then click Save.

The current page is converted to PICT format and saved.
CONVERSION FILE FORMATS USE

Apple Fax

Can only be opened by Apple Fax

PICT 72 dpi

Standard PICT format

PICT 200 dpi

High definition PICT format

Text (OCR)

Text format

Viewing, Editing, and Printing Faxes
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Optical Character Recognition (OCR)

A fax is transmitted as graphic information. A received fax
document cannot be opened with a word processor or
edited as text. The Apple Fax OCR feature allows you to scan
a fax and convert its graphic pixels to text. You can convert
all or part of a document to text.
OCR converts only printed characters in a fax document to
text format. Character recognition is not the same as
handwriting recognition; OCR cannot recognize and convert
handwriting into text.
OCR Dictionaries

When you install Apple Fax, the Installer places some items
related to OCR in a Mimetics folder in your System Folder.
Some of these items are language-specific dictionaries
needed to recognize the words in the document target
language. Dictionaries exist in several languages. You can
obtain dictionaries for other languages by writing to
Mimetics at the address on page ii (copyright page) of this
manual.
To install other dictionaries, simply drag them into the
Mimetics folder. Choose the current dictionary in the OCR
preferences panel.
See also: “OCR preferences” in Chapter 8, “Apple Fax
Preferences” for an explanation of OCR preference options.
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OCR tips

You can increase the chance of successful character
recognition by taking the following precautions. Ask the
originating fax to
m send documents in High Resolution Mode—200 dpi,
sometimes called Fine resolution
m use characters between 10 and 30 points in size. OCR
interprets larger or smaller characters as graphics.
m use outline fonts or TrueType fonts instead of bitmapped
fonts
m insert the document at a right angle (vertically or
horizontally). It must have no more than a 7% slant
OCR works with Apple Fax documents only.
Working with OCR

The OCR process performs the following steps on a selected
portion of a page, on a single page, or on every page of the
entire document.
m

Prepares the data OCR finds pictures and removes them.

m

Analyzes the page OCR locates the columns of text.

m

Processes the page

OCR searches the target language
dictionary for the word closest to the recognized pattern and
places it in text format in the clipboard.

Viewing, Editing, and Printing Faxes

89

Converting part of a document to text

1 Open an Apple Fax document, then select the text you want

with the selection rectangle tool.

2 Click the OCR Selection tool in the tool bar.
OCR

OCR scans the selected text, then places the results in the
clipboard in text format. You can paste the text into
SimpleText, a word processor, or any other program that
supports pasting text. Depending on the OCR preference
settings, you may be presented with a dialog asking you to
identify characters that cannot be determined by the analysis
process. The OCR process maintains character attributes and
page layout as much as possible.
See also: “OCR preferences” in Chapter 8, “Apple Fax
Preferences” for an explanation of all OCR preference
options.
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The OCR process shows you status messages that let you
know about the progress of the text conversion. When the
conversion is complete, the status message indicates “OCR is
finished - the recognized text has been placed into the
Clipboard”.
3 Switch to the Finder.
4 Choose Show Clipboard from the Edit menu.

The text is displayed and you can paste it into another
program.
Converting a page of a document to text

1 Open an Apple Fax document and go to the page you want

to convert to text.
2 Click the OCR tool.

When there is no selection, the OCR process works on the
entire current page. The text is stored in the clipboard and
you can paste it into another program.
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Converting an entire document to text

1 Open an Apple Fax document.
2 Choose Save As from the File menu, then select “Text only”

in the Format pop-up menu.
3 Rename the document or accept the file extension “Text”

that Apple Fax appends to the default file name.
Apple Fax saves your text in SimpleText format. You can
open it with SimpleText or a word processor.
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Creating and Managing
Cover Pages
In this chapter

This chapter explains the functions for creating and managing
cover pages, including
m customizing cover pages
m positioning and resizing fields
m using the grid and aligning fields
m adding graphics
m installing and removing cover pages
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Customizing cover pages

Apple Fax includes a complete set of tools for creating and
managing customized cover pages for your faxes. Several
example cover pages are provided for you. You can modify
these to suit your needs, or you can create your own cover
pages. You can create and install as many cover pages as
you like.
Apple Fax cover editor windows have a lot in common with
many painting and drawing programs. If you have used a
program of this type, you should have no trouble using
cover editor features of Apple Fax.
Cover page fields and labels

Most of the information on your cover page is contained in
fields. The fields that you design are filled in automatically at
the time you send a fax. For example, if you have a Name
field on your cover page, your recipient’s name is
automatically put into it when your fax is sent. You can add
labels for the fields if you like. For example, you might have
the label “Name:” next to the name field. Labels remain the
same for every fax, whereas fields are filled in differently for
every fax from the information in the address book entries of
your recipients and from the information about you in the
Personal preferences.
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Creating a new cover page

To create a new cover page
1 Choose New Cover Page from the File menu. If you prefer to

modify an existing cover page, choose Open from the File
menu and select a cover page.
A new, untitled cover page appears.

Since most users will probably never want to create a cover
page completely from scratch, Apple Fax provides a template
when you create a new cover page. You can move, change,
or delete the fields and labels provided in the template and
add graphics to customize the cover page according to your
needs.
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Using the tool bar

Most of the operations you perform as you customize your
cover page are done with the tools in the tool bar. The tool
bar makes it easy to access everything you need in order to
control the position and appearance of the elements on
your page.

The Selection tool

You use the selection tool to select, resize, move, or delete a
field or graphic.

The Text tool

You use the text tool to create and edit labels associated with
the fields on your cover page.

The Field tool

You use the field tool to add new fields to your cover page.
The field tool is the default tool that is selected when you
create a new cover page.
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The Scale tools

You can scale the view of a cover editor window using the
Zoom In and Zoom Out tools on the right-hand side of the
tool bar, or you can choose a particular scale from the popup menu.

By using the view scale icons and the scroll bars, you can
make the window contents show whatever part of your
cover page you want at whatever size you want.
The Graphic tool

You can include a graphic image on your cover page by
importing a PICT file using the Graphic tool.
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Customizing fields

You start designing a cover page by placing the fields and
their labels on your cover page.
You can control nearly all aspects of a field’s appearance on
the page, including its size and shape as well as the font,
size, and style used to fill in its text at send time.
Positioning and resizing fields

You can position fields anywhere on the page and resize
them to any size you want.
To position a field on the page
1 Select the Selection tool in the tool bar.
2 Click anywhere in the field you want to move and drag it to a

new position on the page.
3 Release the mouse when the field is where you want it.

To resize a field
1 Select the Selection tool in the tool bar.
2 Click anywhere in the field you want to resize.

Handles appear on the corners of the selected field.
3 Click on one of the handles and drag to resize the field.
4 Release the mouse when the field is the size you want.

If you shift-click and drag one of the handles, the resizing is
constrained either vertically or horizontally, depending on
which direction you first move the mouse.
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Modifying fields

Once you have placed a field on your cover page, you can
modify its assignment from the predefined list of fields. For
example, you might decide to change the <Sender Name>
field to <Number of Pages>.
To reassign a field that you have placed
1 Double-click the field that you want to reassign.

The list of fields appears

2 Select the field type that you want.
3 Check “Draw field frame” if you want a border drawn around

the field.
4 Check “White background” if you want the field to be on an

opaque white background. If you want the field information
to appear on a transparent background (over a graphic, for
example) uncheck “White background”.
5 Click Modify.

The field changes according to your settings.
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Using the grid and aligning fields

The cover editor includes a grid to help you align elements
on the page. You can choose to turn the grid on or off and
to show or hide the grid lines, depending on your
preference. When the grid is on, objects snap to the nearest
grid location whether the grid lines are visible or not.
Ordinarily if you are using the grid, you will want to show
the grid lines.
To turn the grid on
1 Choose “Turn Grid On” from the Cover Page menu.

When the grid is on, the menu choice becomes
“Turn Grid Off”.
To show the grid lines
1 Choose “Show Grid Lines” from the Cover Page menu.

When the grid lines are shown, the menu choice becomes
“Hide Grid Lines”.
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You can align elements on the page to the grid or to each
other.
To align fields to the grid
1 Choose Set Alignment from the Cover Page menu.

The Alignment Settings dialog appears.

2 Set the Grid Spacing you want (in pixels) by typing into the

text box or by using the up and down arrows.
3 Choose Grid from the “Align Objects to” pop-up menu.
4 Choose the alignment you want—vertical, horizontal, or

both.
5 Click OK.
6 Choose the Selection tool in the tool bar.
7 Shift-click to select the fields you want to align.
8 Choose Align from the Cover Page menu.
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The selected fields are aligned to the grid according to the
settings you chose in the Set Alignment dialog box.
To align fields to each other
1 Choose Set Alignment from the Cover Page menu.

The Set Alignment dialog appears.

2 Choose Each Other from the “Align Objects to” pop-up

menu.
3 Choose the alignment you want—vertical, horizontal,

or both.
4 Click OK.
5 Choose the Selection tool in the tool bar.
6 Shift-click to select the fields you want to align.
7 Choose Align from the Cover Page menu.

The selected fields are aligned to each other according to
the settings you chose in the Set Alignment dialog box.

102

Chapter 6

Creating fields

Apple Fax places some fields on the new cover page
template when you create it. You can also delete and create
fields, although each field type can only appear once on a
cover page.
To add a new field to your cover page
1 Select the Field tool in the tool bar.

Field tool selected

2 Click in the approximate position you want for your field and

drag the mouse diagonally to create a rectangle
approximately the size you want your field to be.
3 Release the mouse button.

The field you created appears with its type enclosed in
brackets.

The brackets indicate that the information will be filled in
from the recipient information when you send a fax using
this cover page.
The field types come from a built-in list and are entered in
order as you create fields. You can modify which fields are
associated with which field types later if you wish.
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The list of types includes recipient information from the
address book entry, sender information from the Personal
preferences, and information about a particular fax, such as
the number of pages. You can use as many or as few fields as
you like, but you can only use each field type once on any
given cover page.
4 Create the remaining fields for your cover page by repeating

steps 2 and 3 for each field.
Editing label text

You can add text anywhere on your cover page. You may
wish to add text labels to the fields that you create. For
example, you might want the text “From:” to appear above
the <Sender name> field to identify the field.
To add a text label
1 Choose the Text tool in the tool bar.

2 Click where you want the text to appear

A text box appears with the cursor blinking inside it.
3 Type the text.
4 While the text is selected, change the font, size, and style

using the pop-up menus in the tool bar or the Font, Size,
and Style menus.
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Adding graphics

You can add a graphic to your cover page in the form of a
PICT file. Most graphics programs allow you to save your
work in PICT file format and thousands of PICT files are
available from clip art vendors.
To add a PICT file graphic to your cover page
1 Choose Import PICT from the file menu.
2 Navigate to the folder that contains your PICT file, if

necessary, then click Import.
The PICT file you choose is pasted into the middle of your
cover page. You can resize it and move it to any location on
the page you like.
3 Resize the PICT by dragging the handles. Move it by clicking

inside it and dragging.

Resize handle
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Installing cover pages

While editing, you can save your customized cover pages to
any location you like using the Save and Save As commands
in the File menu. However, in order to use the cover pages
you create, you must install them. Only cover pages you
install appear in the Cover Page pop-up menu in the Quick
Fax or Fax Sender print dialogs. You can install and use as
many cover pages as you like.
To install a custom cover page you have created
1 Open the cover page you want to install, if it is not already

open.
2 Choose Install Cover Page from the Cover Page menu.

Once installed, your cover page will be available in the Cover
Page pop-up menu in the Fax Sender and Quick Fax dialogs
until you remove it.
Removing cover pages

You can remove any cover pages that you no longer use so
that they no longer appear in the Cover Page pop-up menu
in the Fax Sender print dialog.
To remove a cover page
1 Choose Remove Cover Page from the File menu.

A list of installed cover pages appears.
2 Scroll to the cover page you wish to remove and select it.
3 Click Remove.

The cover page is removed from the list of installed cover
pages, but it still exists as a cover page and you can always
reinstall it.
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Using the Apple Fax Log

In this chapter

Apple Fax maintains a log of all outgoing and incoming faxes.
This chapter explains the log functions, including
m viewing the fax log
m saving the fax log
m printing the fax log
m clearing the fax log
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Viewing the fax log

The fax log keeps valuable information on all outgoing and
incoming faxes. This information is kept in an internal log
file. To view the fax log
1 Click the Log button in the button bar.

Log button

The fax log appears.
Call types

Log functions

Each row gives information about one call
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Fax log information

The fax log gives you information for outgoing and incoming
faxes. The information includes
m date and time the fax was sent or received
m type (status) of the fax—Sent, Received, or an error type
m phone number (not always known for received faxes)
m duration (hours:minutes:seconds)
Printing the fax log

You can print the fax log at any time by opening the Log
window and choosing Print from the File menu or by
clicking the Print button in the Log window.
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Saving the fax log

You may want to save the fax log from time to time for
archival and record-keeping purposes. The log file is a text
file, and therefore it doesn’t take up much disk space, but
you may still want to save and then clear the log on a regular
basis.
To save the fax log to a tab-delimited text file that can be
opened by a word processor, spreadsheet, or database
program
1 Click the Save button in the log window.

The standard file dialog appears.

2 Navigate to the disk and folder where you want to save the

log file.
3 Type the name you want for the saved file.
4 Click Save.

The fax log is now saved as a file. You can clear the existing
log entries to make room for new entries.
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Clearing the fax log

To make room for new entries and to make the information
in the fax log easier to scan quickly and understand, you
should clear the log from time to time, after saving it to a file
if you wish.
To clear the fax log
1 Open the fax log by clicking the Log button in the main

window.
2 Click the Clear button in the log window or choose Clear

from the Edit menu.
A dialog asks you to confirm clearing the log.
3 Click OK.

The fax log is cleared. As new entries arrive, they appear in
order with newest entries at the top.
You can choose to limit the size of the log, either by setting a
maximum number of entries or by setting a maximum time
limit for entries to be kept. These choices are available in the
Log Preferences.
See also: Chapter 8, “Apple Fax Preferences” for a complete
explanation of Log preference options.
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Apple Fax Preferences

In this chapter

This chapter explains all of Apple Fax’s preference settings,
including
m notification preferences
m modem preferences
m log preferences
m OCR preferences
m personal preferences
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Apple Fax Preferences

Apple Fax allows you to set up your fax environment
according to your needs and preferred way of working. Your
settings are saved in a preferences file. Each time you open
Apple Fax, your settings are restored from the preferences
file so that your fax environment is just as it was the last time
you used the program.
Accessing preferences

To open the Apple Fax preferences window
1 Choose Preferences from the Edit menu or click the

Preferences button in the button bar.
The Preferences window appears.

Preference categories
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The Preferences window is divided into two parts. On the
left is a panel of icons for choosing a category of preferences.
The large panel to the right contains all of the settings for
the currently selected preference category. There are five
categories of preferences—Notification, Modem, Log, OCR,
and Personal. Each of these is described in detail in the
following sections.
Notification preferences

The Notification preferences settings determine whether or
not Apple Telecom Status opens during fax activity.
To set Notification preferences
1 Click the Notification icon in the panel on the left side of the

Preferences window.
The Notification preferences settings appear.

Check the box to have Apple Fax open the Apple Telecom
Status program during fax transmission and reception. If you
leave this box unchecked, you can still access Apple Telecom
Status at any time to monitor fax activity.
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Modem preferences

You need to set certain modem preferences so that Apple
Fax can communicate correctly with your particular modem
hardware configuration.
To set the Modem preferences
1 Click the Modem icon in the panel on the left side of the

Preferences window.
The Modem preferences settings appear.

The options in the modem preferences panel are explained
in Table 9-1.
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Table 9-1 Apple Fax Modem Preferences
PREFERENCE FIELDS

RESULT

Modem choice pop-up
menu

Choose the type that corresponds
to your modem. (If you have an
external modem or a PC card modem,
use the control panel that came with
your modem to choose the port to
which your external modem is
connected or the slot that contains
your PC card.)

Save fax image files

Faxes are transmitted and received as
image files. This checkbox enables
saving sent fax image files. Fax image
files take up disk space and the files
can always be re-imaged if you need to
resend them. So, unless you frequently
resend or forward sent faxes, you may
want to disable saving image files.

Turn off V.17

V.17 is currently the highest speed
standard available for fax transmission.
Many older fax machines do not
support it. In some cases, enabling V.17
may interfere with transmission to
older fax machines that don’t support
it. If you know that the fax machine you
are calling supports V.17, you may turn
it on.
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Apple Fax Modem Preferences (continued)
PREFERENCE FIELDS

RESULT

Turn off ECM

Some fax machines support the
Error Correction Mode (ECM) of
transmission. In some cases, enabling
ECM may interfere with transmission to
older fax machines that don’t support
it. If you know that the fax machine you
are calling supports ECM, you may
turn it on.

Auto-answer

Check this box if you want incoming
calls to be answered automatically.
You can also use the Fax Answering
button in the main window to do the
same thing. If you change the setting
here, your change is reflected in the
main window and vice-versa.

When sending fails
Retry

Sets the number of retries.

Time between tries

Sets the time between tries.

Resend all pages

Resends the entire fax if transmission
fails.

Resend only those
pages not already sent

Sends only the pages that failed to
transmit.
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Log preferences

The Apple Fax log keeps track of all fax transmissions and
receptions. You can set preferences to limit the size of the
log by number of entries or by date.
To set the Log Preferences
1 Click the Log icon in the panel on the left side of the

Preferences window.
The Log preferences settings appear.

You can limit the size of the log by date, number of entries,
or not at all.
The options are
m

Log
entries older than the number of days that you enter in the
value field are deleted.
Delete fax log entries older than [value] days

Apple Fax Preferences
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m

Delete oldest log entries if more than [value] entries

When the size of the log reaches the number you enter in
the value field, the oldest entry is deleted each time a new
entry arrives.
m

Save all log entries No log entries are automatically

deleted, regardless of the size of the log. If you choose this
option, it is up to you to clear the log manually from time to
time so that it doesn’t grow too large and take up too much
disk space.
See also: Chapter 7, “Using the Apple Fax Log” for a
complete explanation of archiving the log to a file and
clearing the log.
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OCR preferences

The OCR preferences control the behavior of the OCR
process of converting received fax documents to text.
To set OCR preferences
1 Click the OCR icon in the panel on the left side of the

Preferences window.
The OCR preferences settings appear.

The options are
m

Default dictionary

Choose the dictionary for the appropriate language from this
pop-up menu. Additional dictionaries may be obtained from
Mimetics by writing to the address given on the copyright
page (ii) of this manual. To install additional dictionaries,
place them in the Mimetics folder inside the System Folder.
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m

Ask for ambiguities if character cannot be
recognized Check this box if you want Apple Fax to ask

you to resolve ambiguities each time it encounters an
unrecognizable character in the text. If the box is not
checked, unrecognizable characters are replaced by the
default replacement character.
m

Display alert after copying recognized text to
clipboard Check this box if you want Apple Fax to put up

an alert message to let you know when it has completed the
OCR process and the recognized text has been copied to the
clipboard.
m

Default replacement character If you leave “Ask for

ambiguities unchecked”, Apple Fax replaces all
unrecognizable characters with the default replacement
character. Enter the character you want to be used as a
replacement. You should use a character that does not
appear in the text very often, like ‘@’, which is the default.
m

OCR memory size The more memory you allocate to the

OCR process, the longer and more complex documents you
will be able to scan. If you get an out of memory message
during the scanning process, increase this value and try
again.
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Personal preferences

Additional settings are grouped in the Personal preferences
category—fax header, fax cover page information, and
default dialing method.
To set the Personal Preferences
1 Click the Personal icon in the panel on the left side of the

Preferences window.
The Personal preferences settings appear.

You can enter up to 20 characters and numbers in the fax
header field. The text you enter will appear at the top of
each page of each fax you send, if the recipient’s fax machine
supports the fax header feature. Fill in the other information
(name, address, etc.) about yourself as you want it to appear
on cover pages.
You can choose either auto or manual as the default dialing
method. You will normally want to choose automatic dialing
unless you have a specific reason not to do so.
See also: Chapter 4, “Advanced Fax Send Options” for a
complete explanation of manual dialing.

Apple Fax Preferences

123

Reverting and saving preferences

There are three buttons at the bottom of the Preferences
window—Revert Panel, Cancel, and OK.
m

Revert Panel restores the previously saved settings for the

currently displayed preferences category.
m

Cancel closes the Preferences window without saving any

changes that have been made to the settings.
m

OK closes the Preferences window and saves the current

settings to the preferences file. The new settings take effect
immediately and remain in effect until you change them
again.
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Using Apple Fax Gateway

In this chapter

Apple Fax Gateway allows you to add fax services to your
PowerTalk Key Chain. This chapter explains the features of
Apple Fax Gateway, including
m configuring Apple Fax Gateway
m adding fax services to your Key Chain
m configuring fax services
m using Apple Fax Gateway
m problem alerts
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About Apple Fax Gateway

Apple Fax Gateway adds fax services to PowerTalk when
used with the appropriate modem hardware. Once you have
installed and configured the software and hardware, you can
send documents to fax recipients, along with other e-mail
recipients, from programs that support the PowerTalk
Mailer. You can also send faxes from the desktop by
dropping printable documents onto PowerTalk information
cards that contain fax addresses. Most importantly, your
received faxes are presented in the PowerTalk Universal
Mailbox along with the rest of your electronic
correspondence. Received faxes appear in your In Tray and
can be opened, viewed, edited, and printed using Apple Fax.
PowerTalk 1.1 or later must be installed in your system
before you can take advantage of the Apple Fax Gateway
features. PowerTalk 1.1 is included with System 7.5.
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Configuring Apple Fax Gateway

You need to configure Apple Fax Gateway before you can use
fax services.
Adding fax services to your Key Chain

Before you can send and receive faxes, you must add fax
services to your Key Chain.
1 Select Key Chain from the Mail and Catalogs sub-menu in the
Apple () Menu.

The Key Chain window appears.

2 Click Add.

The Add Service dialog box appears.

3 Select Apple Fax if it is not already selected, then click OK.
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You return to the Key Chain window. Fax services have been
added, but they are not yet configured.

Configuring fax services

To configure fax services
1 Select Apple Fax in the Key Chain window, then click Open.

The Apple Fax configuration window appears.
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All of the features in the Apple Fax configuration window, as
well as those that are accessed by the Options, Preferences,
and Apple Fax Info buttons, work just like their counterparts
in Apple Fax. These are covered in detail in the earlier
chapters of this guide.
Using Apple Fax Gateway
Sending fax documents

You can send fax documents from any application that
supports the PowerTalk Mailer by including the fax
addresses of one or more recipients. Fax addresses can be
selected from catalog entries or can be typed in using the
PowerTalk Mailer’s Type-In addressing feature. The subject
that you specify in the Mailer appears on the fax cover sheet,
if you checked “Add Standard Cover Page” when setting up
the fax gateway software.
You can add documents created by a program such as a
word processor or paint program as enclosures. You can
enclose any document that can be printed. Note that you
cannot send other types of information, such as sounds, as
faxes. To send fax documents from other programs that
support the PowerTalk Mailer, be sure to choose either
AppleMail or Snapshot format. Refer to the documentation
that came with your program for more information.
If you are using System 7.5 or later, see the step-by-step help
in the AppleMail Guide and PowerTalk Guide in the Guide
menu for detailed instructions on using the Mailer and
information cards.
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Another way to send a document is to drag it onto an
information card, if you have designated the fax address as
the “preferred” electronic address. Adding fax addresses is
explained in the following section.
Adding fax addresses to your PowerTalk
information cards

To add a fax address to a PowerTalk information card
1 Open an information card and select Electronic Addresses

from the pop-up menu.
The Electronic Addresses for the card are displayed.

If you want to create a new information card, open your
personal catalog, select New User from the Catalog menu,
and type in the name for the card.
2 Click Add.
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3 Select Apple Fax, then click OK.

A new, untitled fax address appears.
4 Select the untitled user name and type the name of your

recipient.
5 Select the user name, then click Open, or double-click the

user name.
The Fax Number window appears.

6 Click in the Fax Number field and enter the user’s fax

number, then click the close box.
7 If you leave “Preferred” selected, the fax address is the

preferred electronic address. Whenever you select this user
in the addressing panel or drag a document onto the user’s
information card, the fax address is used.
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Receiving fax documents with PowerTalk

You can receive faxes from any fax machine or fax modem.
When you receive a fax, it appears in your In Tray just like
any other incoming mail.

Opening received fax documents

To open a received fax from your In Tray
1 Double-click the document.

Apple Fax opens it in a fax view window. You can view, edit,
and print it.
See also: Chapter 5, “Viewing, Editing, and Printing faxes” for
complete information about these features.
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Problem alerts

If an error occurs while sending or receiving a fax, you will
get a problem alert in your Out Tray or In Tray.
To see and resolve a problem alert
1 Click the Problem Alert icon in your In Tray or Out Tray.

The Problem Alert appears with an explanation of the
problem.
2 Click Resolve to remove the alert, or simply close the

window to leave it unresolved.
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Some of the more common Problem Alerts are
Some of the enclosure files have been ignored.
Only printable documents can be converted to the
fax format.

You get this message if you enclose a file that cannot be
printed, such as a sound or a program.
The generated fax document is empty and will not
be sent.

You get this message if
m all of your enclosures are of the wrong type (not
printable) and your document itself is empty
m you drag an unprintable document onto an information
card that has fax as its preferred electronic address
m the program that created an enclosed document cannot
be found or cannot be opened for lack of memory
m the program that created an enclosed document cannot
be opened due to insufficient memory
The System Extension ‘Fax Extension’ is not
present in the System Folder.

Apple Fax Gateway requires that the Fax Extension be in the
Extensions folder within the System Folder in order to work.
It is placed there by the Installer program when you install
Apple Fax. If the file subsequently gets moved, deleted, or
damaged, you will need to reinstall it.
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